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Preface
For details, see the following topics:

• About this documentation

• Notation conventions

• Aurea global support

About this documentation
This guide is par t of the documentation set for Aurea CRM.

Notation conventions
This document uses the following notation conventions:

MeaningConvention

Fixed-width font indicates code, path names, file names, envi-
ronment variable names, parameter names, command names,
machine names, URLs.

Fixed-width

Bold Fixed-width  font is used to indicate user input or to
emphasize cer tain lines of code.

Bold Fixed-
width

Italic Fixed-width font indicates a placeholder for which you
must supply a value.

Italic Fixed-width

Bold sans serif typeface indicates the names of graphic user
interface elements such as dialog boxes, buttons, and fields.

Bold Sans serif

In text, italic serif typeface indicates the first use of an impor-
tant term. The term is defined in the glossary.

Italic serif

Underlined text in command lines and parameter descriptions
indicate that you only have to enter the underlined part of the
command or parameter name. For example, if you use
the-LOGFILE parameter in a command, you only need to enter
-LOGF.

Underlined

Brackets enclose optional arguments.[ ]

Braces enclose two or more items. You can specify only one
of the enclosed items. Vertical bars represent OR separators.
For example, you can specify a or b or c.

{ a | b | c }

5AUREA CONFIDENTIAL



MeaningConvention

Three consecutive periods indicate that you can repeat the
immediately previous item. In code examples, they can be
horizontal or ver tical to indicate omissions.

...

An angle bracket between two menu items indicates that you
should choose an item from a menu. For example, the notation
File >  > Exit means: "Open the File menu and choose Exit."

Menu > Choice

Links to related information in other chapters or documents are
indicated using the >> symbol.

>>

Aurea global support
If you encounter a problem while using an Aurea product or require assistance with
downloading the software or upgrading a product release, please open a ticket on
Aurea Support Central. Preferably, search the ar ticles on the Aurea Knowledge
Base for solutions to your issues before opening a ticket.

Information about the support organization is available on Support Central. The
product documentation is available athttps://help.aurea.com/crm/#.

For information about purchasing an upgrade or professional services, contact your
account executive. If you do not know who your account executive is, or for other
queries, contact us through our website.
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1
Introduction
Introduction and overview of the workflow engine.

Workflows allow you to:

• Display related information from various info areas on a single screen; e.g. all
activities a person is involved in

• Define commands that trigger actions

• Access and manipulate data in the database

• Define and depict new relationships in the database

• Distribute processes amongst stations and users by sending workflows via e-mail

• Add, edit and delete data manually or automatically

• Guide users through their daily tasks, determining which data is displayed and
accessible; e.g. all their current contacts including the contact history and links
to associated opportunities, projects and offers

• Define conditions that influence the subsequent steps in the workflow

• Configure overviews in which numerical fields are aggregated

• Create custom links between various info areas and display an overview thereof.
Users can switch between associated records

Triggers and workflows
Learn about the difference between triggers and workflows.

Triggers are used to automatically apply changes to the database, either interac-
tively or in the background. Triggers are initiated by events in the database (e.g.
changes to a record).

Workflows can also display data in the database, in addition to manipulating data.
Workflows are initiated by commands (e.g. clicking on a button).

You can incorporate triggers in workflows.

For more information, refer to Triggers in the Web Administrator Guide.
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Explanation of terms
Learn about the terms used in this guide.

The following terms are used throughout this document:

Modes

There are four different modes available in Aurea CRM. The command bar contains
the icons used to switch between modes.

DescriptionMode

New mode allows you to add new records to the database.

Edit mode allows you to make changes to data in the database.

Delete mode allows you to delete records from the database.

When in new or edit mode, click on Cancel to return to view mode.

Workflows in Aurea CRM can perform different actions depending on the current
mode.

Info areas, levels and windows

Info areas corresponds to the tables in the data model. Functions and triggers
are defined for info areas.

Levels are a representation of these info areas/tables. Data from several info
areas can be displayed in a level, and command buttons are available in each level.
Buttons (which can trigger workflows) and masks (which can be used in workflows)
are defined for levels as opposed to info areas.

A window consists of one or more levels displaying data.

In the workflow engine, levels are used to display the data in a process, and the
entire workflow is displayed in a window. The parent-child hierarchies between the
levels corresponds to the process hierarchy. The workflow itself is the top-most
level, and is the parent of all other levels in the workflow.

Parent and children

Multiple levels can be displayed on screen at the same time in a workflow. These
levels need to be related to one another in the data model.

For example, contact records are added for companies or persons. You can display
companies and persons in one level in the workflow, and contacts in another level.
Because the contact records are children of the company/person records (i.e. directly
linked), the child level displays the contacts linked to the currently selected company
or person.
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Changes to the parent level affect all child levels. If you switch between companies,
then the level containing the contact records is also updated to display the contact
records for the new company. Conversely, switching between records in the child
level does not change the record displayed in the parent level (as the parent record
is the same for both child records). If you close the parent level, all child levels are
closed automatically.

An overview of Aurea CRM's data model is available for each vertical as a
separate PDF document.

Processes in a workflow can trigger other processes. These new processes are
star ted as child processes of the original process. Generally your process hierarchy
is related to the hierarchy in Aurea CRM's data model. You can edit the data model
to add new info areas or create links between existing areas, if necessary, see Data
Model in the Web Administrator Guide.

Keys and indexes
Learn about the use of keys and indexes in Aurea CRM.

Aurea CRM uses indexes to quickly retrieve specific records. Indexes are also used
to associate linked records in the database using Aurea CRM's internal search en-
gine. There are often several indexes available in an info area; one of the indexes
is the unique key. This key uniquely identifies a record in Aurea CRM.

Each field in the index requires a cer tain number of places (see Key Table in the
appendix in the ver tical-specific manuals for details of the indexes in all info areas).

Keys

A record in Aurea CRM has its own unique key. The key always contains information
on the record's parent(s), if applicable. For example, the contact key includes the
keys of the company and person for which the contact was added. Key fields are
stored in records and are used to link records with one another. For example, contact
records include fields that store the company key and person key, thereby associating
the record with a specific company and person within that company.

For companies, persons and contacts, the key is composed as follows (the number
of places required by individual fields are indicated in brackets):

Key fields and placesKey
length

Info area

Co.Gr.(2) + Co.No.(4)6Company

Co.Gr.(2) + Co.No(4) + Pe.Grp.(2) + Pe.No.(4)12Person

Co.Gr.(2) + Co.No(4) + Pe.Grp.(2) + Pe.No.(4) + Date(4)16Contact

Persons are assigned to companies using the company group and number (Co.No.
and Co.Gr.) in their key. The key for contact records in turn uniquely references
both the company and person keys (if applicable).

The person key fields are empty in company-related records, i.e. records that are
stored for a company, not a specific person in a company. In this case, the conditions
Pe.No. = <empty> and Pe.Grp. =
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<empty>" return true. This can be used to determine whether a record is company-
related or person-related.

If your workflow includes companies, persons and contacts, you can display the
persons assigned to each company and the contacts stored for the company or
person.

The key is used to determine which records should be displayed. For example, to
display the persons assigned to a company, the first 6 places in the person key
(Co.Gr. + Co.No.) should match the company key.

In effect, you have three options when displaying contacts:

Compare withCompareOption

Co.Gr.(2) + Co.No.(4)12 placesperson-relat-
ed

Co.Gr.(2) + Co.No(4) + Pe.Grp.(2) + Pe.No.(4)12 placescompany-relat-
ed

Co.Gr.(2) + Co.No(4) + Pe.Grp.(2) + Pe.No.(4) + Date(4)6 placesboth person
and company-
related con-
tacts

Indexes

As well as the unique keys, alternative indexes are available in many info areas.
Indexes are a combination of fields (e.g. Co.Gr. + Co.No, + Pe.Grp. + Pe.No. +
Date). Note that apart from the key, indexes do not generally identify a record
uniquely. For example, one of the indexes available for contacts is the date and
time of the contact. However, there may be any number of contacts scheduled for
the same time.

You can search info areas using indexes just as quickly as with the unique key.
Aurea CRM uses keys and indexes for its internal search functions.

Note:  For a list of all the indexes available in each info area, refer to the Key Table
in the appendix of the ver tical-specific manuals.

Links and relationships in the datamodel
Learn about the links and relationships in a datamodel.

Because a contact must be associated with a company, the Contact info area is a
child of the Company and Person info areas. Consequently, the company for which
a contact record is added needs to be clear from the current context or specified
by the user. For example, when adding a contact from the Company.

+ Person level, the contact is added for the selected company and person. If the
contact is added from an info area not linked to the Company and Person info areas,
the parent record needs to be specified manually.
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Workflow basics
Learn how to create and manage a workflow.

Creating a Workflow

Before defining a workflow, the following should be decided:

• The goals of the workflow

• Whether the database needs to be configured

• Which info areas are displayed in which levels

• How the data contained in the various levels is related in the datamodel

• Which commands trigger what actions

The workflow infoarea
Workflows are defined in the Workflow info area.

Select Info > Workflow from the menu to open the Workflow info area.

Note: You need to be logged on to Aurea CRM with administrator privileges in order
to edit workflows.

The screen contains an overview of the current workflow in tree form on the left.
Click on an element in the overview to edit the corresponding settings.

You can choose to display or hide individual branches in the tree, as in Windows
Explorer. Click on  to display a branch and click  to hide a branch.
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Enter the title of the workflow here.Title

Enter a description of the workflow that is displayed when
the workflow is carried out.

Description

You can assign an icon to the workflow. The icon is displayed
in the level header.

Icon

You can determine which access rights are taken into ac-
count when the workflow is carried out (station, group and
user access rights).

Rights

You can determine how the workflow is executed. For exam-
ple, workflows can be set to run in the background.

General Settings

You can determine a mask for the root process.Mask

Parameters are used by the workflow to store data temporar-
ily. There are two types of parameters: field parameters and
record parameters. Parameters are stored on the parameter
stack, and values on the stack can be sor ted by value.

Parameters

A workflow consists of one or more processes. A process
defines which info area is displayed, what data is available
and which commands trigger which actions.

Processes
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Example
Learn to implement your own workflow.

Workflow concepts are best understood by implementing your own workflow. The
following example builds up a simple workflow to display a rep's contacts and
demonstrates how various processes can be linked to one another. An in-depth
description of the various elements that make up a workflow can be found under
Workflow elements on page 36.
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Note: Workflows can only be defined by the administrator (SU). Before star ting
with the examples, ensure that you are logged on to Aurea CRM with administrator
privileges.

1. Select Info > Workflow to open the Workflow info area.

The tree structure to the left of the screen contains an overview of your workflow.

2. Save the workflow under the name Daily routine. The overview of the workflow
to the left of the screen now displays Daily routine instead of Workflow.

3. Click on Title and enter the workflow's title in all the desired languages. Confirm
with OK.

4. Enter a lengthier Description of the workflow in the same way. The title and de-
scription are displayed while the workflow is executed.
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Displaying today's contacts
A workflow can consist of several processes. The first process in our workflow should
display all of the current rep's contacts that are scheduled for today.

The data displayed in the workflow is taken from the Contact info area. There are
two criteria for selecting the contacts that are displayed: the current rep and the
current date.
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1. Click on Processes in the overview. The Processes table is displayed.

2. Describe the process by entering text in both the Short Text and Description
fields. The Short Text is only displayed in this table. The Description is displayed
once the process is executed.

3. Select New View in the Type column. This determines that a new level will be
opened to display today's contacts.

4. Click in the Definition field. The following dialog box is displayed.

This dialog box is used to select the desired info areas and define how they are
displayed.

5. Click on Select under Info Areas. Select the Contact info area and confirm with
OK. The name of the info area is now displayed below the Select button.

This process only depicts data from a single info area. However, it is possible to
include several info areas in a single process and to configure separate settings
for each info area.

6. Click on Contact in the list below the Select button. This allows you to determine
the settings for the Contact info area.
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7. Enable the Edit option below the list of info areas (do not select New or Delete).
This determines that the contacts displayed can be edited; however records
cannot be deleted or added.

8. Use the Start Mode drop-down list to select the mode (New, Edit, Delete, Display)
that the process is opened with. Choose Display in this case.

9. Use the Read pane to determine the index used to select the contact records in
the database to display.

Select "2. Date(4)+Time(2)" under Index. Enter a Key Length of '4'.

A key length of 4 corresponds to using the date (first 4 places) to select the
records displayed in the workflow. The time is ignored in this case, as we wish
to select all of today's contacts, irrespective of the time. We determine that the
records are selected using a date parameter containing today's date later on.

10.Click on the Condition check box.

As only the contacts for the current rep are to be displayed, enter "Rep ID =
Current Rep" as a variable condition.

11.You need to select a mask used by your workflow. You can specify masks for
both list and mask views. Click on the Load button next to Mask and List. For
the moment, we can use one of Aurea CRM's default masks. Click on Choose
Default Mask in the dialog box that is displayed upon clicking the Load button.
Choose a default mask from the list.

When designing your own workflows, you can use masks designed in the mask
generator, see Mask Generator in the Win Administrator Guide.

12.Enable Start WithList.
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13.The dialog box should look as follows:

14.Confirm with OK. The Definition cell in the Processes table now contains a tick.

Selecting the contacts using a parameter
Learn hot to select contacts using parameters.

To select today's contacts, we need to define a parameter that contains the current
date. The parameter is then compared to the contacts' index over the first 4 places
(the date component).

1. Select Parameters from the tree structure on the left.

2. Enter the following data in the table:

3. Click in the Key Definition cell in process 1 in the Processes table.

4. Enter the following data to determine that the "Today" parameter is used to limit
the contacts displayed.
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5. Close the Key Definition table. You are returned to the Processes table. The
Key Definition cell now contains a tick.

6. Save the workflow.

Note: You could also use conditions to determine that those contact records
scheduled for today are displayed. However, with large volumes of data, this is
a very slow process. Using indexes improves performance considerably and should
be employed whenever possible.

The first test
Before star ting the first test run, make sure there are several contact records stored
for both today and several other days.

Assign some of these contacts to the current rep and some to other reps.

Select Extras > Workflow from the menu and select the workflow. The following is
displayed:

Note that only the Edit button is available from the command bar (and neither New
nor Delete). The name, title and description of the workflow and process are dis-
played to the left (in the currently selected language).

If you change the date of one of the contacts, then the contact is no longer displayed
in the list, as it no longer meets the defined condition.

Close the workflow and return to the Workflow info area.

Second process to display associated companies and persons
Learn how to add a second process to display associated companies and persons

The company and person linked with the selected contact record should also be
displayed. To do so, you need to define a second process and specify how the first
process interacts with the second.
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Process definition

1. Enter a text and description for the second process in the Processes table (click
on the corresponding cell in the empty line). Select New View in the Type cell.
Click on the Definition cell to open the Definition dialog box.

2. Click the Selectionbutton, and select the Company info area. Company is now
listed under the Selection button. Select this entry and enable Edit.

3. Add the Person info area as well, and enable New and Edit.

4. Define "1. Co.Grp(2)+Co.No.(4)" as the index for the Company info area.

5. Enter a Key Length of 6 (2 places for Co.Grp, 4 places for Co.No.).

6. Click on the Key Definition button and select the Contact info area. This
determines that the key is taken from the Contact info area. Remember that the
contact record uses the company group and key to identify the company the
contact relates to. You still need to define that the contact is taken from process
1.

7. Define "1. Co.Grp(2)+Co.No.(4)+Pe.Grp.(2)+Pe.No.(4)" as the index for the Person
info area.

8. Enter a Key Length of 6. Click on the Key Definition button and select the
Contact info area. This determines that all persons in the company entered in
the contact should be displayed.

9. Select a mask to be used by mask and listview.

10.Ensure that the Integrated option is enabled (the default setting). This determines
that both companies and contacts are be displayed on the screen.

11.Click on OK to confirm your settings and close the dialog box.
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Triggering the second process

You now need to define how the second process is triggered from the first.

1. Click on the Command cell in the first process line. In the Command  table, select
"Double-click in list" in the Command cell.

2. Click in the Action field.

3. Choose "Create Child" in the Action cell and enter 2 in the Process cell.

This determines that a double-click on the list in process 1 initiates process 2 as
a child of process 1. Selecting a contact in the first process displays the details
of the associated company or person in the second process.

4. Save the workflow.

Testing process 2

Start the workflow. Double-click on the list in process 1. You should note the follow-
ing:

• Process 1's display switches to the mask mode (this is the default action defined
for a double-click).

• The second process is displayed.

• If you navigate between contact records in process 1, the company/persons dis-
played in process 2 are updated automatically. However, navigating in process
2 has no effect on process 1.

• Each process is assigned to a level. In order to close a process, close the level.
To close the workflow, close the workflow window.

Editing the command

The command defined to open process 2 should be edited as follows:

• A double-click should not cause the display to switch to maskview.

• Process 1 should be locked upon opening process2.

Click in the Action cell in the Command table. Add the following actions to the
"Double-click in List" command in process 1:
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A double-click in process 1 now causes the following actions:

• Child process 2 is star ted.

• Process 1 is locked and can no longer be edited.

• The default command (switch to mask view on double-click) is suppressed by the
"Command Disabled" option.

Unlocking process 1

If you test the workflow in this state, you cannot return to process 1 after exiting
process 2. Process 1 remains locked; in order to work with process 1, you need to
unlock it once process 2 is closed.

Add the "Close" command to process 2 and associate it with the action to unlock
process 1:

Editing the mask and configuring the display

The following changes should be made to process 2:

• Instead of displaying all the persons in a company, only the person entered in
the contact selected in process 1 should be displayed.

• The mask used by process 2 should occupy a larger area of the screen.
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To do so:

1. Edit the definition of process 2:

Ensure that you have selected the Person info area from the list of info areas.
Select the first index in the list. The key is generated based on the contact selected
in process 1, and the key length is 12 (2+4+2+4). This causes the person key to
be compared to the contact key over the entire key length, including the places
used by the Pe.Grp. and Pe.No. fields. When comparing the first 6 places, only
the company keys was compared, and all the persons in the company entered in
the contact were displayed.

2. Enter the following settings under IntegratedDisplay:

This defines that process 2 should be displayed below process 1, and that 20%
of the space available is reserved for process 1.

3. Carry out a test run.

Starting a workflow in aurea CRM win
Learn how to star t a workflow in Aurea CRM win

For details on using workflows in Aurea CRM web, refer to the Aurea CRM Web
Administrator Guide. The following text describes how to star t workflows in Aurea
CRM win.

Starting a workflow from the menu

1. Select Extras > Workflow from the menu. A list of workflows available are
displayed.

2. Select the desired workflow and confirm with OK.

Note that if a workflow requires mandatory input criteria, such as a person, the
workflow is only accessible if the necessary data is available.

23AUREA CONFIDENTIAL

Workflow basics

https://help.aurea.com/crm/crm-web-administrator-guide/index.html
https://help.aurea.com/crm/crm-web-administrator-guide/index.html


Starting a workflow by actions in the database

Workflows can be triggered by database events such as adding, editing or deleting
a record (as with triggers). These events are defined in the Rights module, see
Rights in the User Manual. You can determine which workflows are initiated for
which users by assigning the access rights to these users. You can also specify
that workflows are only activated when cer tain fields are updated, or if a record
satisfies a condition before of after it is edited, see Configuring Workflows in the
Rights Module .

You can also use the Triggers cell in the Rights info area to determine that work-
flows should be star ted. Use this option to combine triggers and workflows that need
to be executed in a specific order (the triggers and workflows are carried out in the
order they are entered).

Note that triggers and workflows can make changes in the database and therefore
themselves initiate fur ther workflows.

Starting a workflow using a button

To star t a workflow with a button:

1. Define a button in the mask generator, as described in Mask Generator in the
CRM Win Administrator Guide.

2. Open the Button Properties dialog box by double-clicking on the button.

3. Click on the Load button under Format, select Workflow and select a previously
defined workflow from the list.

You can also configure buttons to appear as entries in the context menu. For more
information, refer to the Mask Generator topic in the CRM Win Administrator Guide.

You can also star t workflows using buttons in the level header or the New button
in the general toolbar. These are defined in the desktop settings, see Desktop in
the CRM Win Administrator Guide.

Starting a workflow from the icon bar

To add workflows to the icon bar:

1. Select Extras > Define Desktop from the menu.

2. Click the Fixed Icon Bar button.

The Define Fixed Dialog Bar lists all the available workflows under Workflows:
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1. Click the  icon to add a workflow to the iconbar.

2. Click the  icon to determine the settings (text and icon) for the workflow.

For more information on configuring the icon bar, refer to the Desktop topic in the
CRM Win Administrator Guide.

Starting a workflow from a to-do

Workflows can initiated from To-Do records handled by Aurea CRM server. Only
hidden workflows can be executed from To-Do records.

The following settings are required in the To-Do record:

• Enter the Aurea CRM server user in the Rep/Group field of the to-do.

• Select "Calculate" as the To-Do Type.

• Select "Workflow" in the Execution Type field.

• Enter the desired workflow format in the Execution Format field.

Configuring workflows in the rights module
Use the Rights info area to determine that workflows are initiated when cer tain
events occur in the database.

The following events can initiate workflows:

• Changes to data carried out by users, workflows, triggers, imports (only Hidden
workflows) or in the Maintenance module (only Hidden workflows).

• Merging companies or persons: Workflows are initiated when companies or persons
are deleted when merging. No workflows are initiated for child records.

• Functions in the business logic.

Note: Workflows are not initiated by changes to data caused by communication or
importing templates with Aurea CRM cockpit.

These settings apply to all users (including the administrator) assigned these access
rights as either their station, group or user access rights. For details on how work-
flows are affected by extended access rights and on inheriting settings, see Further
Settings for Triggers and Workflows and Inheritance Properties per Element in the
Core Administrator Guide.
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When a database action initiates a workflow, the workflow is added to the stack,
which stores all workflows yet to be executed. Workflows are added to the stack in
the order they are entered in the list. The order in which you enter workflows can
therefore be important.

If you want to execute both triggers and workflows in a specific order, enter both
the triggers and workflows in the Triggers cell in the Rights info area instead. The
triggers and workflows are then executed in the order they are entered in the Trig-
gers table. For more details, see Triggers in the Core Administrator Guide.

Defining workflow events
Learn how to define a workflow event.

To define a database event as a workflow event:

1. Switch to the Rights info area in the Rights module.

2. Click in the Workflow cell of the desired info area. The Workflow info area is
displayed for the selected info area.

3. Double-click on New Line to add a new workflow. The Load dialog box opens.

4. Select a workflow and click OK. By default, the Related cell is enabled. This
ensures that the next workflow is not star ted until this workflow has been
completed. If you disable this option, the workflow is executed immediately if it
is a hidden workflow. Up to 32 workflows may be active at one time.

5. Click in the With Conditions cell to define a condition. The workflow is only
executed if this condition is met, see Conditions in the User Manual.

The condition is tested as soon as the event takes place, and the workflow is
only added to the stack if the condition is met.

Enable the New cell to initiate the workflow when a new record is added. The
workflow is executed once the new record is saved. If a condition is defined in
the With Conditions cell, the condition is tested before the workflow is executed.

6. Enable the Del cell to initiate the workflow when a record is deleted. If a condition
is defined in the With Conditions cell, the condition is tested before the workflow
is executed.

7. Enable the Upd cell to initiate the workflow when an existing record is updated.
The workflow is executed once the record is saved. You can define conditions
that need to be met by the record both before and after it is updated. Define the
condition that needs to be met by the record before it is edited in the Old
Condition cell. Define the condition applied to the updated record in the With
Conditions cell.

If you enable the Upd, Old Condition and With Conditions cells, the workflow
is only executed if the record was changed from the status defined under Old
Condition to the status defined under With Conditions.
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Example: A workflow should be executed if the Status of a contact record is
changed from "Scheduled" (Old Condition) to "Completed" (WithConditions).

8. If the Upd cell is enabled, you can use the Upd Fields column to determine that
the workflow is only initiated after cer tain fields are edited. Click in the Upd Fields
cell to open the Trigger Fields info area which displays all fields in the info area.

• All the fields with a tick in only the Trigger cell (and not the Optional  cell)
must be edited before the workflow is initiated.

• At least one of the fields with a tick in the Optional column must be edited
before the workflow is initiated.

In the above example, the workflow is only initiated once changes are made to
the Date field and at least one of either the Contact or Status fields (or both).
This condition does not affect the New and Delcolumns.

9. Click on  (OK) to return to the Workflow mask.

10.Click on  (OK) to return to the Rights info area.

11.Save the access rights and assign them to the appropriate users, groups or
stations.

Workflow examples
You can find some workflow examples in this topic.

Example 1

This workflow displays all the persons stored for the current company. The workflow
is defined as follows:

Options:

Title = Persons in company

General Settings: Runs in context, Hide star t window Parameters:

Parameters = Record, Source = Extern, Name = COMPANY, Type = Company,
mandatory

Process:

Persons:

• Definition:

Info Area 1 = Company, Input parameter = COMPANY

Info Area 2 = Person, Index = Co.Gr. + Co.No. + Pe.Gr. + Pe.No., Key length
= 6
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Start With List enabled

• Commands: Command = New Input Parameter, Info Area = Company

Action: Parameter = COMPANY, Parameter action = Edit

Action: Action = Refresh

If you switch to a new company using the summary index card, the view is updated
to reflect the new company:

Note that:

• The summary index card is displayed.

• The workflow description is not displayed.

Example 2

This process counts the number of visits by the rep assigned to a company over
the period of a year and enters the value in the FreeN1 field.

Workflow Settings:

Title: Number of contacts per company rep General settings: Hidden

Parameters:

Processes:

Process 1 – "Company"

Definition:

Info Area = Company, Edit

Input Parameter = COMPANY

Command:

Command = Edit, Action

Action 1:

Action = Execute

Action 2:
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Info Area = Company, Parameters = Count, Param. Action = Complete Field, Field
= FreeN1

Action 3:

Action = Save

Action 4:

Action = Exit Workflow; Format = <workflow name>

Input criterion 1:

Info Area = Company, Key Definition: Parameters = COMPANY, Result

Result:

Result = TRUE, Param.Action = Edit, Parameters = Rep, Field = AD1

Input criterion 2:

Result

Result:

Result = Regardless, Action = Create Child, Process = 2, Parent Process = 1

Process 2 - "Contacts"

Definition:

Info Area = Contact, Index = (1)Co.Gr.+Co.No.+Pe.Grp.+Pe.No.+Date+Time, Key
Definition: Company, Key Length = 6

Condition: Status = Done, Contact = Visit

Command:

Command = Next Record, Info Area = Contact, Parameters = Rep, Operator = '=',
Comp. Field = Rep 1

Action 1:

Result = TRUE, Parameters = Count, Param. Action = Add, Content = 1

Action 2:

Result = Regardless, Action = Execute

Action 3:

Result = Regardless, Command execute = Y, Action = Next Record

Action 4:

Result = Regardless, Command execute = N, Action = Edit, Process = 1

Input criteria:

Result:

Result = Regardless, Action = First Record

Result:

Result = Regardless, Action = Next Record

This workflow only applies changes to the company record.
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Workflow properties
Each workflow can have a title and a description assigned in all available languages.

When the workflow is executed, they are displayed in the current Aurea CRM lan-
guage. If no entry has been entered for the current language, the default entry is
displayed instead.

Icon

You can assign icons to processes in a workflow. The icon is displayed in the level
header.

Click on the Icon cell in the line representing the process and choose an icon from
the dialog box that opens. You can also choose to load your own icon using the
Load button to the right of the File field.
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Right settings and denying access

You can use the tree structure to define which rights are applied when the workflow
is executed. In the example below, the station and group access rights are applied,
but not the rep's individual access rights.

You can specify an additional rights format for the workflow under Workflow Rights.

Fur thermore, you can permit or deny access to the workflow by specific stations,
groups or reps.

If you click on Rep, you can choose the reps to whom this setting applies. You can
choose to lock the workflow for the selected reps, or only allow the selected reps
to access the workflow.

General settings

Click on General Settings in the tree structure to access the general settings for
the workflow.

Hidden

Determines whether the workflow runs in the background and cannot be sent to the
foreground. Only

Hidden workflows can be used in Aurea CRM web.

Note: The Aurea CRM server user can only execute hidden workflows.

Runs in Context

Determines whether the workflow is executed with the summary index card displayed.

31AUREA CONFIDENTIAL

Workflow basics



Do Not Activate

Determines whether the workflow is star ted in the background. It is moved to the
foreground using either the Show Process or Show Window actions.

Hide Start Window

Determines whether the star t window hidden.

Enable this setting if you wish to use default processes in your workflow and to be
able to influence their appearance using the workflow's settings (e.g. Start With
List).

Note:  Ensure that any workflows that are defined as Hidden are automatically
closed upon completion. Otherwise the workflow process remains open in the
background.

This does not apply to background workflows that are triggered by navigating in the
summary index card, which are closed once the parent process is closed.

If you define a workflow with the Do Not Activate option enabled, ensure that the
workflow is either brought to the foreground at some point or closed automatically.

Appearance

When the workflow is executing, Information on the workflow is displayed in the
following fields:
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DescriptionField

Name of the workflow.Name

Title of the workflow.Title

The descriptive text entered for the workflow in the
currently selected language.

Description

Describes the current process.

You can also use this field to display text when cer tain
commands are executed, see Actions.

Processes

Editing tables
Learn how to display, delete and edit tables.

Displaying and editing dependent tables

Workflow consists of several elements. Processes are central to a workflow; other
elements are defined for processes. The following diagram illustrates the relation-
ships between the various workflow elements:

The process and parameter elements are accessed by clicking on Processes and
Parameters in the tree structure on the left. The other elements are accessed by
clicking in the corresponding cell in the parent's table; e.g. click the Key Definition
cell in the Processes table to access the Key Definition table.

The Process table is linked to a range of child tables: Input Criteria, Key Definition
and Command. Each process occupies a line in the Process table. The dependent
elements in the process are represented by cells in the line relating to the process.
To edit an element, click on the corresponding cell. If an entry is present for one of
the elements, a tick is displayed in the cell.

You can access the Input Criteria, Definition, Key Definition and Command tables
from the Process table. Similarly, you can access the Action table from the Com-
mand table, and access the Result table from the Input Criteria table.

In addition to the elements related to processes, you can also define parameters.
Parameters are used to store records or field values. The data stored in a parameter
can be used to write data to records, form keys and determine input criteria.
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Deleting data in tables

To delete a specific line, highlight a cell in the line and select Delete line from the
context menu.

To delete all the lines in a table, select Delete all lines from the context menu in
the corresponding table.

Copying data in tables

You can selectively copy individual lines from tables, as well as all lines in a table.
Any associated data in child levels is also copied. If you copy a command, for exam-
ple, any actions defined for the command are also copied.

Copying individual lines

1. Click in a cell in the line you wish to copy.

2. Select Copy line from the context menu. Any data previously stored on the
clipboard is overwritten.

3. If you wish to copy fur ther lines before pasting your data, do the following:

a. Click in a cell in the next line you wish to copy.

b. Select Append line to clipboard from the context menu.

The currently selected line is added to the data already stored on the clipboard,
i.e. the first line you copied.

c. Repeat the process, selecting Append line to clipboard for any fur ther lines.

Copying all lines in a table

1. Select Copy all lines from the context menu to add all the lines in the current
table to the clipboard. Any information previously stored on the clipboard is
overwritten.

2. Select Append all lines from the context menu to add all the lines in the current
table to the data already stored on the clipboard.

Pasting data from the clipboard

Select Paste from the context menu to paste the contents of the clipboard to the
current table. You can only copy and paste data from within the same table. You
can thus copy commands between processes by copying a command from one pro-
cess to the command table in a second process, for example.

Repositioning entries

You can move lines in any table (apart from the Process and Parameters tables)
by dragging lines to the desired position.
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To change the order:

1. Click on the number of the line you wish to move and hold down the mouse button
for a short while. If you now move the mouse, the cursor changes:

2. Drag the line to its new position.

3. Release the mouse button. The line is moved to its new position.
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2
Workflow elements
Elements are the building blocks of a workflow.

Below are the elements of a workflow. You can visit each of these to know the details.

Process
Learn about the processes inside a workflow.

A workflow consists of one or more processes. You can define the following for each
process:

• Title and description in various languages

• Process dependencies (parent-child hierarchies)

• How data from individual info areas is displayed

• Parameters used to select data (keyformation)

• Conditions determining when a process or action is star ted

• Which actions are triggered by which commands

Click on Processes in the tree view to access the Processes table. Enter data by
clicking in the corresponding cells.

Each process can have a title and a description in all available languages.

The short text and description are also displayed in the Processes table in the
Workflow info area. The description is displayed when the workflow is executed in
the language selected by the user.
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Note: You need to enter either a description or short text before you can access
the other cells.

Process types and definitions

The type of process is entered in the Type column. There following options are
available:

DescriptionProcess Type

Opens a new level to display the workflow
data. Click in the Definition cell to con-
figure the settings for the process.

Enter a level in the Level No. cell to ap-
ply the default desktop configuration de-
fined for that level to the workflow (e.g.
header settings), see Desktop in the Win
Administrator Guide.

Note that only the default desktop set-
tings for the level can be used, as the
parent level for levels used in workflows
is the Workflow level and you cannot
define specific desktop settings for the
case where the Workflow level is the
parent level.

New View

Executes the workflow in the level en-
tered under Level No. (i.e. if 1001 is en-
tered under Level No., the workflow is
executed in the Company+Person  lev-
el).

Existing View

Note: You can only edit the process once you have entered a description or short
text.
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Info areas
You can use these settings to determine which info areas are displayed in a process.

The order in which you select the info areas has the following effects:

• If you want to link records, records are linked from the upper info areas to the
lower info areas in the list. In this case, companies are displayed. Persons are
displayed for these companies and contacts for these persons.

• The contacts are sor ted according to the order the info areas are selected; i.e.
by company, then person, and finally by date.

• When navigating between records, you navigate in the lowest info area. In this
case, once you reach the last contact record for a person, you navigate to the
first contact stored for the next person. Once you have navigated through all
persons in the company, you switch to the next company.

Selecting info areas

Click on the Select button to select the info areas. You can navigate in the list by
entering the first letters of the info area name. For example, to navigate to the
Company info area, press 'C', 'O' and 'M' in quick succession.
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Enable the corresponding check box to select an info area.

Deleting Info Areas

To remove an info area, double-click on the name of the info area in the list. To
reposition an info area, delete the info area and add it again in the correct order.

Possible modes
You can determine which modes (New, Edit, Delete) are allowed for each info area.

Display mode is always available.

The corresponding buttons are only visible in the command bar if the corresponding
option is enabled for at least one of the selected info areas in the process. If no
action is assigned to the button in the command bar, clicking the button switches
to the corresponding mode for all info areas for which this mode is enabled.

For example, suppose you are displaying a company and all persons in the company.
New mode is only enabled for the Person info area. Clicking on the New button
adds a new person to this company, not a new company.

You can define actions determining that a specific info area switches to a cer tain
mode. Even if a mode is disabled for the info area in the Definition dialog box, you
can still switch modes using actions. This allows you to automatically switch modes
at specific stages in the workflow but prevent users from switching modes manually.

Start mode

The Start Mode drop-down list determines which mode is active when the process
begins. You need to select a mode that is enabled for at least one of the info areas
displayed.

If you select a mode that is unavailable for an info area, that info area is opened in
display mode.
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Input parameters
Data stored in record parameters can be used as input criteria for a process.

You can only select record parameters that are of the same type as the selected
info area. If you want to transfer keys between info areas, you need to use the Key
Definition table to do so.

The order in which records are sor ted is also determined by the parameter. You can
therefore also use input parameters to sor t data in processes based on freely defined
criteria.

Read
This pane is used to determine the criteria according to which records in the process
are selected.

You can use:

• Keys or indexes from other info areas in the same or parent processes. The key
is defined under Definition in the Process table.

• Field parameters or fields from record parameters. These keys are defined in the
KeyDefinition table.

Index
You can enter one index per selected info area.

The index determines the following:

• The order in which the records are displayed.

• The index used as a key to compare and select records.

The first index in the list is always the info area's unique key.

Key length and key definition
You can use data from other info areas to determine which records are displayed
in a process.

Records are selected using the index fields. By determining the length of the key,
you can specify which fields are used to select records.

Each index field requires a number of places in the index. The number of places
used by a field is indicated in brackets in the index.

Suppose you want to define a process that displays companies, persons and contacts
as follows:

• All the persons are displayed for a company

• All the contacts are displayed for a person
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In this case, records are selected as follows:

• All companies in the database

• For each company in the database, all persons containing the company's key

• For each person found, all contacts containing the person's key

The Co.Gr. + Co.No. + Pe.Grp + Pe.No index is selected for the Person info area:

• Co.Gr. uses 2places

• Co.No. uses 4places

• Pe.Grp. uses 2 places

• Pe.No. uses 4places

Note: These figures do not correspond to the length of the fields; the contents of
the fields are stored in a compressed format.

The first 6 places of the person index contain the company key (Co.Gr. + Co.No).
In order to select all persons in a company (based on the company key), click the
Key Definition button.

Select the Company info area and set the key length to 6 (2 places for the company
group and 4 for the company number):

To return all the contacts stored for the persons found, you need to compare the
company and person keys stored in the person records (Co.Gr., Co.No., Pe.Grp
and Pe.No.) to those in the contact records.

Because the key is compared with both the company and person keys, the length
of the key is 12 in this case (2 + 4 + 2 + 4):

The info areas you specify under Key Definition need not be the same info areas
as selected using the Select button.

41AUREA CONFIDENTIAL

Process



For example, if process 1 displays a company, and process 2 is a child of process
1, the key defined for process 2 can refer to the company in process 1. You can
also use parameters to select records.

The order of the info areas in the list determines the following:

• Links within a process are always from top to bottom. The key defined for an info
area selected under Selection can always access those info areas that are listed
above it.

• Navigation always takes place within the last info area entered. If this record is
linked to a previous info area, both info areas are updated when navigating
between records.

Note:  If you select data using input parameters, you can still use the key to fur ther
restrict the records displayed.

Descending

Enable the Descending option to sor t records by descending indexes.

For example, if you select contacts based on the date and time, the contacts are
ordered by date and time. If you enable Descending, the most recent contact is
displayed first.

Sum Total

If you enable this option for an info area, values are displayed as sum totals (if this
is applicable). Other fields are left empty. Currency values are converted to the
base currency first.

Condition

You can specify conditions that limit the records that are displayed. Click on the
Condition field to define or edit the condition. Once you have defined a condition,
the check box is enabled.

Note:  If possible, use the index to restrict the number of records first. Applying
conditions to a large number of records can impact negatively on performance.

Presentation
This pane allows you to specify masks and list masks used by processes.

You can also determine whether the process is displayed as a mask or list when
star ted, and whether the level is integrated or displayed separately.
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You can choose to use a default mask or a previously defined custom mask. You
can also define your own mask, see Mask Generator in the Win Administrator Guide.

If you are integrating default processes in a workflow and wish to override their
default UI settings, you need to enable Hide Start Window in the general settings,
see General Settings.

You can then choose to display the process as a list etc.

Integrated

If a child process is opened, it occupies a por tion of the space available. Use the
Size(%) fields to determine how much space is retained by the parent process.

Hidden

If enabled, the workflow runs in the background and cannot be sent to the foreground.

Hide window

If enabled, determines that the process is star ted in the background and is hidden,
until sent to the foreground using the "Show Process" action.

Note:  Ensure that processes running in the background are either terminated
automatically or sent to the foreground at some point.

Mask
You can determine which masks are used by the workflow.

You can specify a mask for both list and mask view.

1. Open the Definition dialog box by clicking on the Definition cell in the process.

2. Click on the Load button to the right of the Mask or List fields. The following
dialog box is displayed:
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3. You can define a new mask or select an existing one. If you decide to use an
existing mask, you can choose to use either a default mask (supplied by update)
or one you have created yourself in the Mask generator, see Mask Generator in
the Win Administrator Guide.

You need to select a mask, otherwise all data is displayed as if you had selected
the Data > All Mask Fields option and the workflow generates errors whenever you
double-click in the mask (unless you have disabled the default action, which is to
switch views).

Note: You can edit existing masks in the mask generator. Star t the mask generator
(either using the Define Mask button or from the database module by selecting
Extras > Edit Mask) and load the desired mask (File > Load).

Use conditional formatting from info area

Enable this option to apply the conditional formatting defined for the info area to
the workflow level.

Configuring the appearance of processes
Learn how to configure the appearance of processes upon creation.

You can determine the appearance of processes created using the "Load Level",
"Create" and "Create Child" actions by entering the appropriate settings in the
Content column of the Actions table.

The following entries are available:

parent Size=x

Size of the parent window as a percentage of the available area.
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childSize=x

Size of the child window as a percentage of the area available to child processes.

integrate

Use this setting to display the window using the integrated view.

horizontal

Use this setting to determine that any child processes of the new process should
be arranges horizontally. This setting does not apply to the "Load Level" action,
which automatically applies the user's desktop settings or the user's last settings
custom settings for the level outside of the workflow.

Vertical

Use this setting to determine that any child processes of the new process should
be arranges ver tically. This setting does not apply to the "Load Level" action, which
automatically applies the user's desktop settings or the user's last settings custom
settings for the level outside of the workflow.

Example:

Content = integrate, parentSize = 30, horizontal

This displays the new process in the integrated view; the parent process is assigned
30% of the available screen area; any child processes of the process are arranged
horizontally.

Commands
The Command table is used to determine which commands trigger which actions.

The action carried out is determined by conditions and the current mode.

You can define any number of actions for each command. To define the actions
associated with a command, click on the cell in the Action column.

Commands are triggered by:

• Icons in the command bar

• Field changes by the user

• Records received from other processes

• Buttons in the mask. Buttons are added to the mask in the mask generator, see
Mask Generator in the Administrator Guide

• Double-clicking in a list

• Closing a process

• Switching between records
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The action associated with a command is specified in the Actions column and defined
in the Actions table.

The Commands table contains the following columns:

Command
Select the command you want to respond to from the list in the Command column.

The following table lists the commands available and how they are triggered from
within the workflow.
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TriggersCommands

These commands are triggered by the corresponding
buttons in the command bar.

New Edit Delete

If no info area is specified, the command is executed
for all info areas for which this mode is permitted.

These commands are triggered by navigating between
records. The process needs to be in view mode.

Previous Record

Next Record

Previous Page

Next Page

First Record

Last Record

These commands are triggered by the corresponding
buttons in the command bar. The buttons are only
available in new and edit mode.

Save, Save+Exit, Cancel

This command is triggered when the level is closed.Close

These commands are triggered when the user switches
between mask and list view. For example, select Mask
to determine which actions should be carried out if the
user switches the display to mask view.

Mask List

This command is triggered when a user double-clicks
a record in the list.

Double-click in list

These commands are triggered when a user switches
between records the list.

Item in list

New item in List

Item in List
takes effect before the new record is the active record.
You can therefore apply actions to the record the user
moved from.

New item in List takes effect after the target record
has become the active record.

This command is triggered by clicking on a field. The
target field is specified in the Info Area and Field
columns. This command is only permitted in view mode.

Mouse click on field
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TriggersCommands

You can respond to users clicking on icons in the mask.
Enter the number of the icon in the Level No. column.
To determine the number, open the mask in the Mask
Generator and select Options > Show all Elements
from the menu. Find the bitmap elements, and manually
count through the bitmaps (the first bitmap's number
is zero) until reaching the desired icon to determine its
number.

Icons can be added to masks using the Mask Generator,
see Mask Generator in the Win Administrator Guide.

Mouse click on icon

These commands are applied if the contents of a field
are changed.

Actions defined for Select before Field are carried out
before the changes are stored in the database.

Actions defined for Select after Field are carried out
after the changes have been stored.

Specify the field the command applies to in the Info
Area and Field  columns.

Select before Field Select
after Field

This command is triggered whenever a record is re-
ceived from another process.

Receive Record

These commands react to the Load Level and Position
in Level  actions (specified in the Actions table).

Load Level Position in
Level

This command reacts to the user navigating between
records in the parent level. For example, you can reread
a parameter or refresh the display.

New Input Parameter

These commands react to actions in standard process-
es.

OK

Find Mark

Mode

Use the Mode column to determine that an action is only carried for a command out
when executed in a specific mode. If you do not enter a mode, the action applies
to all available modes.

Conditions

Use the Info Area and Condition column to determine that an action is only carried
out if the currently active record (in the specified info area) meets cer tain conditions.
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Comparing parameters
You can compare parameters to a field in the selected info area or with a fixed value
using the Parameter, Operand, Comp. Value and Comp. Field fields.

Specify the parameter in the Parameters column. Enter the type of comparison in
the Operand field. The following operators are available:

• = equal

• > greater than

• < less than

• >= greater than or equal

• <= less than or equal

• <> not equal

• () contains

• )( does not contain

Either enter a comparison value in the Comp. Value column, or specify a field with
which to compare the parameter in the Comp. Field column.

Linking conditions
You can link several conditions, making the execution of an action dependent on
multiple conditions.

There are two types of links: AND and OR. All conditions linked with an AND must
be met for the condition to be fulfilled. At least one condition (or sub-set of condi-
tions) linked with OR must be met for the condition to be fulfilled.

Example of linking conditions

In the above example, the action is only carried out, if:

• All 3 conditions linked with AND (2,3 and 4) are met

• and (at least) one of the conditions linked with OR (0,1) is met.

Prompts
You can also prompt users as part of your workflow.

The user's response (yes/no) can also be treated as the result of the evaluation of
a condition.
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Enter the question in the available languages in the Notes column. Use the Question
column to determine whether the user is only prompted (empty entry) or asked a
question ('Y or 'N'). If you ask a question, you can use the users response to deter-
mine fur ther actions.

If you associate several actions with a command, you can determine whether each
individual action is carried out based on the answer given (or in any case).

Use the True, False or Regardless entries for the result in the Actions table to
determine whether actions are carried out if the user answers 'Yes' (True), 'No'
(False) or in any case (Regardless).

Parameters
The New Input Parameter command allows the workflow to react when the user
navigates in a parent level.

Data can be reread or the display refreshed. You need to specify the target info
area under Info Area. Specify the actions applied to parameters using the Param.
Action column in the Actions table, see Parameter Actions.

Actions
The Actions table is used to define which actions are carried out for each command.

These actions can involve processes, commands, buttons, triggers, single letters,
e-mails as well as parameters.

If you define several actions, the actions are carried out in the order they are defined.
After the actions have been carried out, the default action is also carried out.

Note: You can suppress the default action.

Executing actions based on conditions

You can enter the following types of conditions when defining commands:

• Conditions applied to data in the database

• Conditions applied to parameters

• Conditions based on the reply a user gives to a prompt, see Prompts.

The Result column is used to determine in which case the action is carried out:
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Always<empty>

If the condition was met or the user answered "Yes" to a
prompt

True

If the condition was not met or a user answered "No" to a
prompt

False

Always (even if the condition could not be evaluated; e.g.
a parameter was missing)

Regardless

Action columns
You can find the list of action columns in this topic.

The following actions can be selected from the Action column:

51AUREA CONFIDENTIAL

Actions



DescriptionAction

Use Execute to carry out the default command associ-
ated with an action. For example, if the user clicks on
the New button, the default action is to add a new
record. If the user double-clicks in the mask, the view
switches between mask and list mode by default.

Execute

You can therefore execute the default command at any
position in the list of actions (rather than as the last
command).

No fur ther commands are carried out (this suppresses
the default command as well).

Command Disabled

Exits the workflow. Enter the name of the workflow in
the Format  column.

Exit Workflow

Enter a number in the Process column to close the
process with that number. If you do not enter a number,
the process to which the action belongs is closed.

Close

All child processes are closed.Close Children

An independent process is opened. Use the Content
column to determine the appearance of the new pro-
cess, see Configuring the Appearance of Processes
upon Creation .

Create

The process entered in the Process column is opened
as a child process. Use the Content column to deter-
mine the appearance of the new process, see Configur-
ing the Appearance of Processes upon Creation .

Create Child

Sends a process (specified in the Process field) to the
foreground.

Show Process

Sends a process (specified in the Process field) to the
background.

Hide Process

Sends the star t window to the foreground.Show Window

Sends the star t window to the background.Hide Window

Refreshes the sor t order in a process; e.g. if a change
to a field has resulted in a different sor t order.

Refresh Parent Refresh
Child

Sends records (Info Area column) to other processes
(specified in the Process column).

Send Record Send to Par-
ent Send to Child
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DescriptionAction

Deletes records in the current or other processes
(specified in the Process column).

Remove Record Remove
from Parent

Remove from Children

Activates the process entered in the Process column.
If no number is entered, the current process is activat-
ed.

Activate Process

Lock Process prevents any changes to a process until
the process is unlocked with Unlock Process.

Lock Process Unlock Pro-
cess

Focus Process locks all other processes, until focus
is removed using Remove Focus.

Focus Process Remove
Focus

Changes the text displayed in the process description
when the workflow is running to the text specified in
the Notes column.

You can include parameters in the text. Specify the
parameter in the Parameter  column. To determine
where the parameter is displayed, enter a '<#>' at the
appropriate position in the text.

Alternatively, you can specify the parameter number
manually following the hash character (e.g. <#27> for
parameter 27), as well as the field number separated
by a semicolon for record parameters (e.g. <#29;13>
for field 13 in parameter 29).

Parameter numbers are displayed in the No. column in
the Parameters  table (opened using Parameters in
the tree view).

Example: If your parameter contains "update software
AG", entering "You may not make any changes to <#>"
would display the following:

"You may not make any changes to update software
AG".

Set Text
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DescriptionAction

These actions correspond to clicking the corresponding
buttons in the command bar in view mode.

Specify the target info area in the Info Area column. If
you do not specify an info area, the action applies to
all info areas for which this mode is enabled in the
Definition dialog box.

If you specify a target info area, the mode is activated
for this info area, even if the mode is not enabled in
the Definition dialog box.

New Edit Delete

These commands save the record (in new and edit
mode). Save + Exit also exits the process. If the last
process is closed, the workflow is closed as well.

Save+Exit

This action corresponds to clicking the Cancel button
in the command bar. Any changes to the record are
ignored and the user is returned to view mode.

Cancel

These commands switch the display to either mask or
list view.

Mask List

These commands switch between records.Prev. record Next record

These commands move to the next or previous page
in the list.

Previous page Next page

These command switch the display to the first or last
record.

First record Last record

Corresponds to clicking on the button whose ID is en-
tered in the ID Button column.

Press Button

These commands enable or disable the button whose
ID is entered in the ID Button column.

Enable button Disable but-
ton
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DescriptionAction

Starts a trigger or other format (workflow, dashboard,
single letter, mask, analysis, XML, report, spreadsheet,
timeline).

Specify the format as follows:

Using the format type and name:

Enter the type (numeric) and name of the trigger in the
Format cell, separated by a semicolon, e.g.
"30;My_Dashboard".

Using a record parameter:

Enter the type in the Format cell, followed by a semi-
colon. Specify the field in the record parameter in the
Parameter and (the right-most) Field cells, and select
Complete Field in the Param. Action  cell.

Using a field parameter:

Enter the number type in the Format cell, followed by
a semicolon. Specify the parameter in the Parameter
cell.

Using a string stored in a field:

Enter the type in the Format cell, followed by a semi-
colon. Specify the field parameter in the Info Area and
(left-most) Field cells.

Trigger

An e-mail is sent to the selected company or person.
If you initiate this action from a contact, the text stored
in the contact as well as the document are included as
attachments.

E-mail
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DescriptionAction

Generates a DDE single letter for the selected company
or person.

The format used to generate the single letter can be
specified as follows: Using the format name:

Specify the transfer format used by the letter in the
Format cell. Using a record parameter:

Specify the field in the record parameter in the Param-
eter and (the right-most)

Field cells, and select Complete Field in the Param.
Action  cell. Using a field parameter:

Specify the parameter in the Parameter cell. Using a
string stored in a field:

Specify the field parameter in the Info Area and (left-
most) Field cells.

Single Letter

Opens a new level in the workflow. Specify the number
of the level to open in the Level No. column. Use the
Content column to determine the appearance of the
new process, see Configuring the Appearance of Pro-
cesses upon Creation.

Use the Close Level action to close a level again.

Load Level

Displays a specific record in the target level specified
in the Level No. column. To display a record in another
process, enter the process number in the Process
column.

The record is identified in one of two ways:

From the current context; i.e. the currently selected
company, person etc. By passing a record parameter,
specified in the Parameters column.

Position in Level

Closes the level specified in the Level No. column.Close Level

Opens the document stored in the parameter (record,
document link or document path) or current process
(info area and document field).

Open document
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DescriptionAction

Copies a record to the clipboard, similar to the Copy
menu command. Specify the source info area in the
Info Area column or the source record parameter in
the Parameter column.

Copy Record

Pastes the record stored on the clipboard. Specify the
target info area in the Info Area column.

Insert Record

Executing actions based on the result of a command
The "Execute" action carries out the command that triggered the action.

You can determine that other actions are then carried out, depending on whether
the command was executed successfully or not.

Use the Command executed column to determine under which conditions fur ther
actions are carried out:

Always carry out this action<empty>

The action is carried out if the command was executed suc-
cessfully

Y

The action is carried out if the command was not executed
successfully

N

For example, the "Next record" command triggers a series of actions. The command
can either be carried out successfully (i.e. there are fur ther records) or unsuccess-
fully (the last record is already selected):

Buttons
Buttons are also used in the mask generator to add entries to the context menu.

Buttons can be added to masks in the mask generator.

For more details, refer to Mask Generator topic in the Win Administrator Guide.
Workflows can react to all of Aurea CRM's internal buttons available in the Button
Properties dialog box (trigger buttons, single letter, etc.).
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You can also determine the level the target buttons is present in. This allows Aurea
CRM to carry out the action associated with a button in a different level from the
current level.

To do so, define an action of the type Press Button and enter the number of the
target level in the Level No. field.

If the button is defined in the workflow level, the message is first passed to the
workflow level. If no processing takes place there and the button is a trigger button,
then the associated trigger is star ted in the target level.

If the button is only defined in the target level, the message is only passed to the
target level and the action associated with the button is carried out there.

If no target level is specified, messages for trigger buttons (IDs 1200-1209) are
passed to the current level, unless the message is otherwise processed by the
workflow or the current level is a workflow level.

Accessing other formats
You can trigger other workflows, dashboards or single letters from workflows by
setting the action to "Trigger".

Define an action of the type "Trigger" and enter the desired format in the Format
column. Use the same notation as for trigger buttons:
<Format type>; <Format name>

Opening levels
You can open new levels using actions in the workflow.

You can also open a specific record in the new level. The record is either specified
from the current context (i.e. the currently selected company, person etc.) or is
passed as a record parameter.

The Load Level action opens the level specified in the Level No. column.

The Position in Level action switches the view to a specific record in the target
level. The record must either be the current record in the current workflow level or
passed as a record parameter. Specify the target info area in the Info Area column.

Use the Load Level command in conjunction with the Position in Level command
to ensure that the target level is displayed.

Parameter actions
Parameter actions are actions that are applied to a parameter.

The following types of actions are available for parameters:
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DescriptionParam. Action

You can add, change and remove individual parameters
on the parameter stack. Specify the parameter affected
by the action in the Parameters column.

You can specify the parameter's process in the Process
column.

You can use the Edit parameter action to apply a reg-
ular expression to a field value and to write the result
to a parameter:

New Edit Remove

• Select the source field using the Info Area and right-
most Fieldcell.

• Enter the target parameter in the Parameters cell.

• Select Edit in the Param. Action cell.

• Enter the regular expression in the Content cell. For
information on the syntax used by regular expres-
sions, see Regular Expressions Syntax in the Admin-
istrator Guide and  http://msdn.microsoft.com/en-
us/library/bb982727.aspx.

All parameters are removed from the stack.Clear

You add, subtract, divide and multiply numeric param-
eters. Use the Content  column to specify the value to
be added, subtracted etc.

Add Mul Sub Div

You can either Append a string to the end of a string
value or overwrite the existing value using Insert.

Append Insert

Data stored in field parameters can be written to fields.
You can write the following types of data to the field
specified in the Info Area and Field columns:

A fixed value entered in the Content column (double-
click in the Content column to select catalog values
from a list).

Data from other fields in the same record. Leave the
Parameters field empty and specify the source field in
the right-most Field column.

Data from a field parameter specified in the Parameters
column Fields can only be completed in edit or new
mode.

Complete Field
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The New Input Parameter command allows the workflow to react when the user
navigates in a parent level. Data can be reread or the display refreshed. You need
to specify the target info area under Info Area. Specify the action to parameters
using the Param. Action  column in the Actions table, see Actions.

• Command: Command = New Input Parameter, Info Area =Company

• Action: Parameter = "Initial Company", Param. Action =Edit

Navigating between companies updates the "Initial Company" parameter, and fur ther
actions can be triggered using the new company. This command can be intercepted
by any process.

Examples
Here you can refer to some examples for action workflow item.

Opening a Child Process

Clicking on (trigger) button 1200 in display mode in process 1 should star t process
2 as a child. Process 1 should be locked for the duration of process 2.

Closing a Child Process

Once process 2 is closed, process 1 is unlocked.

Completing Fields

Clicking on button 1200 in display mode should transfer the contents of the Rep
parameter to the Rep 1 field in the company record. To do so, you have to ensure
that the mode is switched to edit mode before performing the update and exit edit
mode with Save+Exit.

60AUREA CONFIDENTIAL

Chapter 2: Workflow elements



Sending and Receiving Records

Clicking on button 1200 in process 2 triggers two commands and sends the allocation
record to process 1. The reps stored in the Rep fields are then entered in the corre-
sponding fields of the sales group displayed in process 2.

Process 2:

Process 1:

Triggering Actions with Field Changes

In this example, an action is triggered by editing the Country field: If the country
is changed (e.g. from Austria to Germany), the process' text field should display
"Austria -> Germany". The parameter is added to the text using '<#>'.

The first command is carried out before the new value is applied to the database:
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The next command is carried out after the new value is stored:

Keys
Use the Key Definition table to select records based on data stored in a record
parameter.

This allows you to:

• Incorporate records displayed earlier in the workflow.

• Define processes independently of other processes, yet still access data from
other processes.

• Define links between records (e.g. enter a person key in a different person record)
and edit these associations within the workflow.

Use the Key Definition table to define which fields in the record parameter are
compared to which fields or indexes in the process.

Note: You should only use parameters that contain a value used to form a key, for
example the company number. The last value added to the parameter stack is used
to form the key.

You can compare parts of the field contents using the Offset column. Use Limit  to
specify when to abort a search.

The Key Definition table contains the following columns:
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DescriptionColumn

Select the record parameter used to form the key here.Parameters

The process that the parameter used to form the key
is defined in.

Process

The field in the record parameter that is to be compared
with the index.

Field

These fields are used to define which field from which
info area is used to compare keys.

Target Info Area Target
Field

Examples using keys
This topic has some examples that demonstrate the use of keys.

Linking to processes that are not parents

Process 2 is not a child of process 1. All contact records for the company (and as-
sociated persons) in process 1 should be displayed in process 2. The company
record is stored as a parameter and compared to the contact keys.

Records are selected by matching up the first 6 places of the key (12 places would
only return the company-related contacts).

Linking to external data

Generating keys for external data works much the same as in the previous example.
You only need to change the parameter's Source to "External".
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Key formation using free fields

Keys can be formed using data from records. In this case, free fields are used in
this database to store the person key, if a contact person moves between companies
in the database. The existing person record is neither deleted nor merged, preserving
the associated records (contact history, interests etc.). The old company and person
keys are copied to free fields in the new record (Co.Gr. to FreeC1, Co.No. to FreeN1,
Pe.Grp. to FreeC2 and Pe.No. to FreeN2).

Note: This process could also be implemented using relationships and triggers.
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To display the contacts with this person from the previous company:

1. Define a new parameter called "Current person". Select Record under Parameters
and Person under Type.

2. The key defines which fields are compared to the fields stored in the parameter.
The "Co.Gr. +Co.No. + Pe. Grp. + Pe. No. + Date" index is used for comparison
purposes. The key is compared over the first 12 places (i.e. the company key and
the person key).

3. A click in the list of persons triggers two actions. Define the following actions for
this command:

The first line determines that the parameter Current Person from the process
(process 2) is added to the parameter stack. The second line determines that
child process 5 is star ted. The contacts are displayed in process 5.

4. Determine which fields in the record parameter are compared with which fields
in the index:
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Input criteria
Learn about the input criteria workflow elements.

You can select data in workflows based on conditions that are dependent on the
parent processes. To do so, use the Input Criteria and Result tables.

Input criteria also provide other options: you can determine that a process is only
opened if cer tain conditions are met by the parameter, or choose to open additional
processes as well.

Use the Input Criteria table to:

• Apply conditions to parameters

• Determine that a process is only opened if conditions are met

• Search the database

• Access keys formed using parameters

• Define the relationships between records and processes

• Define various actions dependent on these results
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OptionColumn

Use this column to determine whether the condition is
linked with other conditions using a logical 'AND' or
'OR'.

Link Operand

You can search for and select records using indexes.
Determine the info area in the Info Area column and
the index you wish to use in the Index column.

Info Area Index

Determines which records are returned: records with
the same index (Equal), records with higher indexes
(Greater, GreaterEqual), records with lower indexes
(Less, LessEqual), or the first or last record (First or
Last).

Read Type

You can use parameters to form keys.

If you enter a Key Length of '-1', the length of the key
is set to the length of the parameter entered under Key
Definition.

Click in the Key Definition cell to open the Key Defini-
tion table and define the key.

Key Length Key Definition

You can define fur ther conditions applied to the records.Condition Extended Cond.
Not Included

You can apply conditions to parameters and compare
them to either fixed values or fields in the info area
being searched.

Select the parameter in the Parameters column. Define
the comparison using the Operand, Comp. Value and
Comp. Field columns. Select the field to compare the
parameter with in the Comp. Field cell. To compare
the parameter with a fixed comparison value, enter the
value in the Comp. Value  field.

Parameters No.

Operand Comp. Value
Comp. Field

Used to configure how the result is used (see below).Result

Enter text in all available languages to be displayed
when the workflow is carrying out this task.

Comment

Result
Use the Result column to determine what happens if records meet the defined
conditions or not.

If you only enter a condition, and leave the Result column empty, the conditions
are used to determine whether the process entered in the Process column is opened.
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OptionColumn

Determine whether the actions entered here take place
if the result of the comparison in the Input Criteria ta-
ble is TRUE or FALSE, or regardless of the result.

Result

These options affect the parameter stack. For more
details, see Parameter Actions .

Parameters Process
Param. Action Content

Field

These options affect processes in the workflow, see
Actions .

Action Process

Parent Process

Select the field from the info area entered in the Info Area column in the Input
Criteria table. Otherwise the settings are similar to those for actions.
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Defining parameters
Learn how to define parameters for input criteria.

Steps to define parameters:
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1. Define parameters for the Area field and the current company record:

2. Define the following commands and actions in process 2:

The condition is "Area <> <empty>".

3. Enter the Text and Description of the next process, and set the Type to "New
View". Click on the cell in the Input Criteria column.

4. Determine that the value stored in the parameter Current area should be compared
to the Area value stored in all company records, and those records returned where
the values correspond ('=' in the Operand field).

If the condition is met (the result is TRUE), this record should be added to the
parameter stack under Current company. All the companies that meet this con-
dition are added to the stack.

5. Click on the cell in the Result column. Enter the following in the Result table:

6. Close the table. The Result column now contains a tick. Close the Input Criteria
table. The Input Criteria cell now also contains a tick.

7. Click the cell in the Definition column. Determine that you want companies to be
displayed.
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8. Define that the company data are taken from the parameter stack under Input
Parameter.
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3
Testing a workflow
This section provides a quick overview of how to test your workflow.

You should determine:

• Whether the workflow meets your requirements

• Whether the functions are defined correctly

• Whether the workflow's performance is acceptable

• Whether the workflow contains errors

The formal definition of the workflow should include a list of Requirements, listing
the levels and commands and their requirements.

Ask the person requesting the workflow to review the finished documentation to
ensure that the workflow meets their demands.

Functionality
Here you can find the checklist to test that the workflow functions correctly and to
track down possible problems.

Below is the checklist:

Possible solutionsTestScenario

Define the correct rights set-
tings; check the configuration
settings.

Check that the workflow star ts
correctly.

Star ting

See the section on Trou-
bleshooting .

Check that the correct data is
displayed when accessing
various levels or info areas.

See the section on Trou-
bleshooting .

Check that the level contains
the correct data. If a level is
opened from several com-
mands or levels, test each
scenario.

Level
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Possible solutionsTestScenario

Define masks and lists or pre-
vent access to list or mask
view.

Switch between list and mask
view in all the levels, and
check that the masks and lists
are all defined correctly or that
switching is denied.

Masks

Deny access to new mode,
change the key definition or
use parameters to generate
keys.

Test that new records are en-
tered correctly in all the levels
and that all the keys are also
entered.

Adding records

Edit the key definition.Test that navigating between
records in each level works as
planned.

Navigating between
records

Edit the key definition; remove
erroneous records.

Ensure that only the desired
records are displayed when
you navigate.

See the section on Trou-
bleshooting .

Clear the parameter stack; see
the section on Troubleshooting
.

Execute each command at
least once and in as many sit-
uations as possible. If a com-
mand makes changes to the
parameter stack, carry out the
command several times to test
whether old values remain on
the stack.

Commands

Edit the Result column for the
action or the Question column
for the command.

Test that actions are only car-
ried out if the correct reply is
given to a prompt.

Prompts

Lock the process or give the
process focus.

Consider whether switching
between levels could cause
problems (e.g. when adding a
dependent record).

Focus

Remove the focus.Ensure that the focus is re-
moved from a level if it is set.
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Possible solutionsTestScenario

Configure the rights settings
accordingly.

Ensure that you are not treat-
ing data in the workflow differ-
ently from in the rest of Aurea
CRM.

Data

Configure the rights settings
accordingly.

Star t the workflow as a user
(without administrator privi-
leges) and test that it is impos-
sible to remove links and inter-
nal codes by mistake.

Security

Performance
Learn about the performance improvement for a workflow.

Add enough records and test the workflow under conditions that approximate your
work environment as closely as possible.

The following impact on performance:

• Data that is not searched for using a key

• Conditions applied to large volumes of data

• Sort options

If you search for data using keys, it should be possible to use 10,000 records over
a network without performance problems.

The following steps can improve performance:

• Reduce the volume of data that is searched.

• If you search through the database several times in a similar manner, save the
results of the first search as parameters and use these parameters in later stages.

• Add indexes using the data model for fields that are used to search or sor t large
volumes of data.

Troubleshooting
This topic describes possible sources of errors and how you can track down the
cause of a problem.

To simplify troubleshooting, you can enable logs for workflows in the configuration
settings, see Workflow in the Configuration topic of the Core Administrator Guide.
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There are two types of errors:

• Records are displayed incorrectly.

• Commands are executed incorrectly.
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Common Errors and Causes
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Cause / SolutionErrorScenario

Define the input criteria.Level not opened
from a command

Level

Enter the level number in the command.

The index or key length is missing.Too many recordsRecords

The level is not opened as a child.None / too few
records

The key used to select records is too long
causing records to be excluded.

Check that you are using the correct in-
dex to select records.

The record parameter is of the wrong
type.

The order in which the actions are carried
out is wrong; the process is called first
and then the parameter entered.

The wrong records
are displayed

The parameter stack was not cleared.Too many records
displayed when ac-
cessing the level a
second time

Info Area and Field entered incorrectly
or left blank.

Parameters are
empty

Parameters

Wrong parameter entered.

The parameter is of the wrong type.Mathematical and
string operations do
not work

Many default buttons are level-dependent
and cannot be used in the workflow. In
many cases you can define the same
functionality yourself.

Default buttons are
unavailable

Buttons

Wrong button ID. Check that the ID of the
button is the same as the value entered
in the command.

Actions are not car-
ried out when the
button is clicked

The trigger format is spelled incorrectly.
Open the trigger in the Trigger info area,
and copy the trigger's name using Ctrl+C.
Enter the name in the workflow using
Ctrl+V.

Triggers are not ex-
ecuted

Trigger

The source info area has not been speci-
fied.

Spread the actions over several com-
mands, and execute these one after an-
other. Test where the error lies and fix
the problem.

The result is incor-
rect for commands
that trigger several
actions

Actions
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Making Values Visible

When troubleshooting, make sure you keep track of which values are stored in the
records and parameters after each step.

To display the values:

Select View > All Mask Fields from the menu.Records

Define a process with this parameter as an input param-
eter.

Record Parameters

Display the parameter using the Set Text action.Field parameters
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4
Sending a workflow by e-mail
Learn how to send workflows to other users.

Aurea CRM allows you to send workflows to other users, including the formats used
by the workflow (masks, triggers, trigger masks, DDE formats, catalog values).

Note:  Rights formats are not included.

You should ensure that the following applies:

• The sender and receiver should have the same language version of Aurea CRM
installed.

• No formats that use the same name as formats in the workflow should be present
on the receiver's Aurea CRM. Formats with the same name are overwritten!

Sending a workflow

To send a workflow:

1. Select Info > Workflow from the menu to open the Workflow info area.

2. Select E-mail from the context menu. A list of the available workflows is displayed.

3. Select a workflow. Enter the first few letters of the workflow's name in the Name
field to quickly navigate within the list.

4. Confirm with OK. You e-mail client is opened. The workflow you selected is
included as an attachment.

5. Enter a recipient.

6. If you wish, enter body text.

7. Send the e-mail.

Importing the workflow from an e-mail

To import a workflow received in an e-mail:

1. Open the Workflow info area.

2. Select Sync. Mail from the context menu. Aurea CRM searches your inbox for
e-mails containing workflows. To reduce the length of the search, make sure your
inbox contains only a limited number of e-mails. If the sender included any text
in the e-mail, the text is displayed.

3. A log of the formats that were imported are displayed.
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4. Click OK to confirm.
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5
Documenting workflows
Workflows and their processes should be documented, as with any other database
application that affects several info areas.

This topic focuses on the information that should be included in your documentation.

Documenting workflow goal
You should include a brief description of the workflow's purpose in general terms.

The goals should be formulated so that non-technical staff members can understand
them. Technical details concerning the execution of processes should be dealt with
later.

Documenting workflow processes
Learn how to document workflow processes.

Every workflow consists of at least one process. Each process displays cer tain data
and allows user interaction. Processes can be linked with one another and parame-
ters can be transferred between processes.

For each process, you should include the following information:

• A brief description of the general purpose of the process, including the modes
available to the user.

• An overview of the info areas and data included in the process including the
indexes used to select and sor t data.

• An overview of the process hierarchy and a description of how the info areas in
the process are linked to one another; e.g. using which index.

• An overview of how processes are linked to and interact with each other.

• An overview of the commands available to the user.

• Any restrictions that apply to the process.

• The masks used by the process. In the case of custom masks designed in the
mask generator, include details on any custom buttons or entries in the context
menu that allow the user to interact with the workflow.
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You can display several info areas in the same level. You should pay particular at-
tention to the following:

• Only one info area per level should include a 1:n link. (e.g. a person, all contacts
for this person (1:n) and the activity for which the contact was added).

• New records should be added from the same level as the parent info area or from
a child of the level containing the parent info area. Otherwise, keys need to be
either entered manually, using parameters or by a trigger.

• If you want to add data to several records in a level, you should prevent access
to the New button for adding data, and define a dedicated button instead.

• The parent-child hierarchies in the workflow should reflect the hierarchy in the
datamodel.

• If you want to link an info area to several other info areas, define a level for each
type of link.

Note:  Aurea CRM ignores the first two limitations in the Company+Person level.
You therefore need to specify whether you wish to add a new person or company
when adding a new record.

You can also use Aurea CRM cockpit to manage and document formats, which include
workflows. Furthermore, you can document any changes to the data model. in Aurea
CRM cockpit and publish your documentation to PDF, HTML and Word formats. For
more information, contact your update representative.

Documenting data model
Each process includes information from one or several info areas. You should
document which info areas are displayed in which processes, the index used to sor t
and select records and any restrictions that apply.

Remember to consider how the info areas are related to one another in Aurea CRM;
i.e. which info areas are parents and which are children. An overview of the data
model for each version is available as a separate PDF document.

You can display existing data in a new form; e.g. displaying the top ten companies
by revenue. However, some applications may require you to configure the data
model to meet the requirements of the workflow. For example, if you add a problem
resolution record and want to associate any number of contact records with it, you
need to save the problem resolution record in the database. Furthermore, you need
to enter its key in the associated contact records.

If you edit the data model itself, you should document any such changes and provide
a description of the new data model.
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Types of links

1. 1:1links

Occur rarely, as it generally makes more sense to integrate this type of information
in a single info area.

Example: Offer and Order

2. 1:n links

Examples: Company - Persons; Activity - Contacts; Questionnaire - Surveys; etc.

3. n:m links

n:m links can only be implemented by using a third info area. For example, using
the Contact info area, you could associate a person with several activities and
an activity with several persons. This is possible because contacts are linked to
both persons and activities, and both persons and activities can be linked to
several contacts. In this sense, an n:n link is a 'double' 1:n link.

If required, you can add an info area to the data model to establish an n:m link
between two info areas.

Note:  Not all links in Aurea CRM are used in both directions. There is no function
used to display the activities to which a person or contact is assigned, for example,
or the contact linked to a survey. The first case is technically feasible, in the second
case, the contact record does not include a suitable index.

Searching in the datamodel

Aurea CRM allows you to search according to those fields for which there are indexes
(e.g. the company name, synonym, address and group from the company search).
If you want to search within your data model:

• either use indexes,

• or limit the volume of data that is searched.

Commands and actions
You should provide information on the commands and associated actions in a
process.

The following should be documented:

• The name of the command in Aurea CRM; e.g. Double-click inList

• Any conditions and restrictions that affect the execution of the command

• The associated action(s); e.g. create child process 2. Remember that the order
in which commands are executed can affect the behavior of the workflow.

• Any parameters used by the command and/or action.
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• User prompts and how the responses influence the course of actions.

• Any changes to the database carried out by the action. You should list both the
info area and field that are affected.

Documentation for the end user
For complex workflows, you should provide documentation for the end users.

Include the following information in your documentation:

• Introduction (detailing the workflow's functionality)

• Levels and info areas involved

• How to access the workflow

• Links to other areas or workflows of relevance

You should document the following information for each level:

• How levels are embedded in the workflow

• How the level is accessed

• What information is displayed on the screen

• The functions of fields in the level

• Actions and how they are triggered

In contrast to the documentation for workflow designers, the end user documentation
should not be concerned with the internal workings of the workflow (parameters,
indexes, etc.).
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6
Parameters
Parameters are used to effectively handle data within a workflow.

You can use parameters to store data within a workflow to:

• Transfer data between fields

• Define criteria for opening processes or carrying out actions

• Select records

• Sort records

For example, you can use parameters to:

• Integrate the record from which the workflow is star ted into the workflow (e.g.
star t the workflow from a person and display all the activities for which contacts
with this person exist).

• Use system information, such as the date or current rep as a star ting point.

• Display data in a process depending on the parent process.

• Define sor t criteria and limits, e.g. to show the top 10 companies by revenue.

Defining parameters
Learn how to define parameters and where.

Parameters are defined in the Parameters table. Click on Parameters in the overview
to open the Parameters table.

You need to specify the parameter type and where the data stored in the parameter
is taken from. You can also initialize a parameter with a specific value, if necessary.

Parameters either store a single value, such as the contents of a specific field, or
they can be used to store an entire record.

There are two types of parameters: Field or Record. Field parameters store data
from a field. Record parameters store an entire record.

The following columns are included in the table:

Source

You can determine the source of the parameter: External sources (i.e. from outside
the workflow) or Internal sources (i.e. from within the workflow). External sources
also include system data, such as the current date or time.
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Name

Enter a name used to identify the parameter within the workflow. Whenever you can
select a parameter, Aurea CRM provides a list of the available parameters for you
to choose from.

Type

You need to determine the type of parameter.

If the parameter is a record, choose the info area that the record comes from. Enter
the first letter of the info area's name to quickly navigate in the list.

Field parameters can be numeric (integers, positive integers and floating point
numbers) or contain strings, Boolean values, dates and times.

Note:  A field parameter with the type set to Time and Max set to '1' always stores
the current time.

Mandatory

This column is used for external parameters. If you enable the Mandatory option,
the workflow can only be star ted if a suitable record is found.

For example, if you define a person as a mandatory parameter, you can access the
workflow from the Company + Person info area, provided a person is stored for
the current company. You can also star t the workflow from all child info areas, irre-
spective of whether they are company or person-related. If an external parameter
is defined as mandatory, you cannot star t the workflow from independent info areas.

Content

You can initialize a field parameter with the contents of this field.

Variable

Use this column to define variable parameters, such as the current rep or date, as
well as variables defined in the Configurationinfo area for fields in the Station,Rep
and RepAddnal Info info areas, see General Settings in the Configuration topic in
the Core Administrator Guide.

The "Variables" entry provides access to variables defined in the Variables info
area in the Rights module. For more information, see Variables in the Core Admin-
istrator Guide. To initialize a parameter with one of these variables:

1. Select "Data Field" in the Parameters column.

2. Select "Extern" in the Source column.

3. Select "Variables" in the Variable column.

4. Double-click in the Content column to select the desired variable from a list.

Alternatively, you can enter the variable's station and record number("ID = <station
no.>, <record no.>") or the record ID ("ID = <record ID>") in the Content field.
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Sort

You can determine the sor t criteria used to sor t parameters on the stack. When
performing recursive operations on data, use the sor t order to determine the order
in which data is processed and output. As you cannot sor t lists in workflows, use
the parameter sor t order to output data in a specific order.

You can either sor t record parameters by ascending or descending order according
to their value.

Max.

Use the Max. column to limit the maximum number of parameters that are stored.
If this value is exceeded whilst executing the workflow, the first values (according
to the sor t order) are retained.

If you do not enter a value, no limit is set (i.e. you can use as many parameters as
your system allows).

Key formation using parameters
Learn how to reuse parameters.

You can add parameters to the parameter stack, allowing you to use the same pa-
rameter to store several items of data. The last parameter added to the stack is
used to form the key. You should therefore ensure that parameters used to generate
keys only contain a single value or that the order of parameters on the stack is clear.
For more details, see Keys.

87AUREA CONFIDENTIAL

Key formation using parameters


	Table of Contents
	Notices
	Preface
	About this documentation
	Notation conventions
	Aurea global support

	Introduction
	Triggers and workflows
	Explanation of terms
	Keys and indexes
	Links and relationships in the datamodel

	Workflow basics
	The workflow infoarea
	Example
	Displaying today's contacts
	Selecting the contacts using a parameter
	The first test
	Second process to display associated companies and persons


	Starting a workflow in aurea CRM win
	Configuring workflows in the rights module
	Defining workflow events
	Workflow examples

	Workflow properties
	Editing tables


	Workflow elements
	Process
	Info areas
	Possible modes
	Input parameters

	Read
	Index
	Key length and key definition

	Presentation
	Mask
	Configuring the appearance of processes


	Commands
	Command
	Comparing parameters
	Linking conditions
	Prompts
	Parameters

	Actions
	Action columns
	Executing actions based on the result of a command
	Buttons
	Accessing other formats
	Opening levels
	Parameter actions
	Examples

	Keys
	Examples using keys

	Input criteria
	Result
	Defining parameters


	Testing a workflow
	Functionality
	Performance
	Troubleshooting

	Sending a workflow by e-mail
	Documenting workflows
	Documenting workflow goal
	Documenting workflow processes
	Documenting data model

	Commands and actions
	Documentation for the end user

	Parameters
	Defining parameters
	Key formation using parameters


